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Introduction

About Fretspace
Fretspace is a chord and scale editor for guitars and other fretted instruments. 
It allows you to create charts of chord, scale, and arpeggio shapes, and can be 
used to create charts for any fretted instrument in any tuning. You can create 
your own shapes by clicking to add and remove dots that represent fretted 
notes, or you can modify shapes by moving them around the fretboard or by 
inverting them to create new inversions. Fretspace will identify and label any 
chord or scale that you have created. Playing around with shapes in Fretspace 
is  a  great  way  to  understand  how  the  fretboard  works  for  a  particular 
instrument or tuning!

There are also chord and scale pickers that allow you to choose virtually any 
chord,  scale,  or  arpeggio  that  is  possible  in  the  current  tuning.  Fretspace 
calculates  fingerings  for  chord  and  scale  shapes,  and  also  allows  you  to 
change the fingering if you wish to do so. There are options for labelling the 
notes and degrees in a chord or scale shape, and for coloring the root notes. 
Charts can be printed, and shapes can be copied and pasted in PDF format to 
other  programs.  Most  of  the  chord  and  scale  shapes  in  this  manual  were 
copied directly out of Fretspace and pasted into Nisus Writer.

System requirements 
Fretspace should run on any Mac with macOS 10.11 or later.

Help and support
Help and support are available from the Help menu.
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Documentation
Select  Welcome  from  the  Help  menu  to  display  the  Welcome to Fretspace 
dialog, which contains a Readme file and Release Notes.

Select  Fretspace User Guide  from  the  Help  menu  to  view  this  manual  on 
screen.

Select  Fretspace Tutorial  from the  Help  menu to  display the  Using Fretspace 
tutorial.

Support
Support is provided via a discussion forum where you can ask for help from 
other users and from the developer. To access this forum, click on Support in 
the Help menu. The discussion forum is also a place where you can discuss 
Fretspace and provide feedback.

About this manual
This  is  a  reference  manual,  which  provides  detailed  information  about 
Fretspace functionality. If you are new to Fretspace, you might want to start by 
reading  the  accompanying  tutorial,  Using  Fretspace:  A  Guided  Tour  (select 
Fretspace Tutorial from the Help menu).

If you are reading the manual or tutorial on screen, you can navigate around it 
by clicking on items within the Table of Contents,  or by clicking on cross-
references in the text. You can also navigate back to your starting place using 
the Back command (normal shortcut: ⌘[ ). Use the Search command in your 
PDF viewer to find items within the Table of Contents and elsewhere.

Typographical conventions
This manual (and the accompanying tutorial) uses a different font to identify 
words and phrases that represent user-interface items or keyboard shortcuts. 
Examples  include:  the  Copy  command in the Edit  menu and its  associated 
keyboard shortcut ⌘C.
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In this example the symbol ⌘ represents the Command key, which is normally 
next to the space bar on keyboards. This is a modifier key, which you hold 
down while pressing the following key (C). Other keyboard symbols include:

⌘ The Command key, also labelled as cmd
⌥ The Option key, also labelled as alt
^ The Control key, usually labelled as ctrl
⇧ The Shift key
⎋ The Escape key, usually labelled as esc

Using Fretspace
Fretspace is a program for serious guitarists (and for anyone who is serious 
about playing any other kind of fretted instrument) at  any level  of  ability: 
beginner, intermediate, or advanced. Making music with a guitar or similar 
instrument is one of the most fun things that you can do, and it gets more fun 
as you get better at it! Fretspace helps you to unlock the fretboard and find 
new ways to play chords and scales and see how they are related to each 
other.

Fretspace contains chord and scale pickers that allow you to choose shapes for 
almost any possible chord or scale. Don’t be intimidated! You don’t need to be 
able to play every chord and scale that Fretspace offers. Fretspace includes 
exotic  scales—such  as  the  Double  Harmonic  scale—that  few  guitarists  (or 
other musicians) play or have even heard of. If you are an advanced musician, 
or you are interested in exotic scales and chords, you can use Fretspace to 
explore them. Otherwise you can just ignore them.

A good way to use Fretspace is to create and print your own charts of any 
chords and scales that you wish to learn. See Setting page size, orientation and 
scale on page 26 if you want to print a chart at a larger scale so that you can 
read it more easily.
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Fretspace for beginners

Playing chords
If you are a beginner, start with easy chords in first-fret position, such as the 
following guitar chords.

E

2 3

1

A

1 2 3

D

1

3

2

G

32

1

C

1

3

2

E7

2

1

A7

1 2

D7

2 3

1

G7

3

2

1

C7

1

3

2

4

Em

2 3

Am

2 3

1

Dm

2

3

1

F

3

2

1 1

Bm/F#

3

1

4

2

B7

2

1

3 4

You can use Fretspace to print out your own version of this chart, and perhaps 
add some other chords, such as Em7, Am7, and Dm7 and alternative versions 
of E7 and A7.
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Playing melodies
If you are interested in playing lead guitar, start by learning easy forms of the 
(standard) Pentatonic scale and move on from there to the Blues scale, which 
has one additional note. There are five main shapes of the Pentatonic scale, 
and  these  can  be  used  to  play  melodies,  fills  and,  riffs  anywhere  on  the 
fretboard.

C Major Pentatonic

2
G

A

C

D

E

G

A

C

D

E

G

A

C Major Pentatonic

5 A

C

D

E

G

A

C

D

E

G

A

C

C Major Pentatonic

7
C

D

E

G

A

C

D

E

G

A

C

D

C Major Pentatonic

9
D

E

G

A

C

D

E

G

A

C

D

E

C Major Pentatonic

12 E

G

A

C

D

E

G

A

C

D

E

G

These shapes are repeated in the second octave of the fretboard. Here are the 
first two shapes in a higher octave.

C Major Pentatonic

14
G

A

C

D

E

G

A

C

D

E

G

A

 

C Major Pentatonic

17 A

C

D

E

G

A

C

D

E

G

A

C

Notice that an A Minor Pentatonic scale is the same as a C Major Pentatonic 
scale, and that other scales can be created by moving these shapes along the 
fretboard: a B Minor Pentatonic scale is the same as an A Minor Pentatonic 
scale, two frets higher.

C Major Pentatonic

5 A

C

D

E

G

A

C

D

E

G

A

C

A Minor Pentatonic

5 A

C

D

E

G

A

C

D

E

G

A

C

B Minor Pentatonic

7 B

D

E

F#

A

B

D

E

F#

A

B

D

Effectively, this means that knowing five simple pentatonic shapes allows you 
to play in any key (major or minor) anywhere on the fretboard.
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The five main shapes of the Blues scale are similar to the five main shapes of 
the Pentatonic scale, but they contain an extra (chromatic) blues note. Here are 
the five main shapes of the A Minor Blues scale.

A Minor Blues

2
G

A

C

D

Eb

E

G

A

C

D

Eb

E

G

A

A Minor Blues

5 G

A

C

D

Eb

E

G

AA

CC

D

Eb

E

A Minor Blues

7
G

A

CC

DD

EbEb

E

G

A

C

D

Eb

E

A Minor Blues

9
G

A

C

D

Eb

E

G

A

C

DD

EbEb

EE

A Minor Blues

12 G

A

C

D

Eb

EE

GG

A

C

D

Eb

E

The extra note in this scale is a flattened fifth (Eb). This gives an additional 
bluesy flavor to the sound of this scale. Notice that an A Minor Blues scale 
contains the same notes as a C Major Blues scale, where the extra chromatic 
note (Eb) is now a minor third.

A Minor Blues

5 G

A

C

D

Eb

E

G

AA

CC

D

Eb

E

C Major Blues

5 G

A

C

D

Eb

E

G

AA

CC

D

Eb

E

You can use these shapes to play lead guitar for any blues song. The basic 
rules for playing blues leads are simple.

1. If the song is in the key of A minor or A major, you can use an A Minor 
Pentatonic or Blues scale over the entire song. Ditto for any other key: use 
a G Minor Pentatonic or Blues scale for songs in G minor, and so on.

2. If the song is in the key of A major, you can also use an A Major Pentatonic 
or Blues scale, although an A Minor Pentatonic or Blues scale sounds best 
over D chords. Ditto for any other key: you can use a G Major Pentatonic 
or Blues scale over the chords of a G major blues song, although G minor 
scales sound best over C chords.

The reason that an A Minor Pentatonic/Blues scale sounds best over D chords 
(in the key of A major) is because it contains the flattened seventh (C) of a D7 
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chord.  By analogy,  you can also  use  an E Minor  Pentatonic  scale  over  A7 
chords and a B Minor Pentatonic scale over E7 chords.

Other useful scale shapes include diagonal pentatonic shapes that allow you 
to move between different box positions, and are also helpful for memorizing 
note positions on the fretboard. See Diagonal shapes on page 80.

Use Fretspace to print out your own scale charts to learn from.

Fretspace for intermediate players
If you are at an intermediate level, you might want to look at different chord 
inversions and different types of chord, or you might want to use different 
tunings  such  as  Drop-D  and  DADGAD,  which  are  popular  with  folk 
guitarists. Listen to Davey Graham if you are interested in DADGAD!

You could also move on from Pentatonic and Blues scales and learn the Major 
scale, starting with shapes that are most similar to the Pentatonic shapes that 
you already know. Use Fretspace to create your own chart with the following 
shapes.

C Major

2
G

A

B

C

D

E

F

G

A

B

C

D

E

F

G

A

C Major

4
A

B

C

D

E

F

G

A

B

C

D

E

F

G

A

B

C

C Major

7 B

C

D

E

F

G

A

B

C

D

E

F

G

A

B

C

D

C Major

9
D

E

F

G

A

B

C

D

E

F

G

A

B

C

D

E

F

C Major

12 E

F

G

A

B

C

D

E

F

G

A

B

C

D

E

F

G

Analyzing scale shapes
It’s  worth noting that scales can be reduced to a collection of  single-string 
shapes. The standard Pentatonic guitar shapes that are listed in the Fretspace 
for beginners section can be reduced to just two single-string shapes that are 
repeated on different strings. For the C Major Pentatonic scale, the two string 
shapes that are repeated are (1) E-G, A-C and (2) D-E, G-A, C-D. The same 
string shapes occur in scale shapes at different fret positions, and the sequence 
of string shapes remains the same, although the starting point changes. If we 
take the scale shape that is played at the fifth fret position, the first of these 
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string shapes is played on the second and first strings (and duplicated on the 
sixth string), and the second shape is played on the fifth, fourth, and third 
strings.

First Shape

5 A

C

E

G

A

C

Second Shape

5 D

E

G

A

C

D

The same string shapes are used for scale shapes at other fret positions. Here 
they are at the twelfth fret position: the first string shape is played on the sixth 
and fifth strings (and duplicated on the first string), and the second shape is 
played on the fourth, third, and second strings.

First Shape

12 E

G

A

C

E

G

Second Shape

12 D

E

G

A

C

D

Seven-note Major scale shapes (for guitar) can also be reduced to three single-
string shapes. For the C Major scale the string shapes are: (1) A-B-C, D-E-F, (2) 
G-A, and (3) B-C-D, E-F-G. If we take the shape that is played at the fourth fret 
position, the first of these shapes is played on the sixth and fifth strings (and 
duplicated on the first string), the second shape is played on the fourth string, 
and the third shape is played on the third and second strings.

First Shape

4
A

B

C

D

E

F

A

B

C

Second Shape

4
G

A

Third Shape

4 B

C

D

E

F

G

Here are the same shapes at the seventh fret position.
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First Shape

7 A

B

C

D

E

F

Second Shape

7
G

A

Third Shape

7 BB

CC

DD

E

F

G

In this way, five different shapes of the Major scale are reduced to three single-
string  shapes,  which  always  occur  in  the  same  order:  a  three-note  shape 
repeated twice (A-B-C and D-E-F), a two-note shape (G-A), and another three-
note shape repeated twice (B-C-D and E-F-G). The sequence then repeats, so 
that  the third string shape is  followed by the first  string shape.  The same 
sequence  of  string  shapes  is  used  at  different  fret  positions,  although  the 
starting point differs.

Dominant Pentatonic scale
Another scale that you might want to learn is the Dominant Pentatonic scale. 
Use Fretspace to create your own version of the following chart.

C Dom. Pentatonic

2
G

Bb

C

D

E

G

Bb

C

D

E

G

Bb

C Dom. Pentatonic

5
Bb

C

D

E

G

Bb

C

D

E

G

Bb

C

C Dom. Pentatonic

7
C

D

E

G

Bb

C

D

E

G

Bb

C

D

C Dom. Pentatonic

9
D

E

G

Bb

C

D

E

G

Bb

C

D

E

C Dom. Pentatonic

12 E

G

Bb

C

D

E

G

Bb

C

D

E

G

The  C  Dominant  Pentatonic  scale  contains  the  same  notes  as  a  C  Major 
Pentatonic scale, except that A is replaced by Bb, the dominant seventh note of 
a C7 chord. You can use a dominant pentatonic scale over any dominant chord 
from the same root (C Dominant Pentatonic over C7 and so on). There are two 
string shapes in this scale. At the seventh fret position they are:
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First Shape

7
C

D

Bb

C

D

E

C

D

Second Shape

7 E

G

G

Bb

The first shape is used on the sixth, fourth, and third strings (and repeated on 
the first string) and the second shape is used on the fifth and second strings.

Dorian Pentatonic scale
Another useful pentatonic scale is the Dorian Pentatonic scale. This is related 
to the Dominant Pentatonic scale in that an A Dorian Pentatonic scale contains 
the same notes as a D Dominant Pentatonic scale: in music terminology they 
are two modes of the same scale.

D Dom. Pentatonic

4
A

C

D

E

F#

A

C

D

E

F#

A

C

A Dorian Pentatonic

4
A

C

D

E

F#

A

C

D

E

F#

A

C

The Dorian Pentatonic scale can also be seen as a Minor Pentatonic scale in 
which the minor seventh note has been replaced by a major sixth:

A Minor Pentatonic

5 A

C

D

E

G

A

C

D

E

G

A

C

 

A Dorian Pentatonic

4
A

C

D

E

F#

A

C

D

E

F#

A

C

The Dorian Pentatonic is used by blues guitarists such as Robben Ford to give 
a jazzy flavor to blues solos. There is a matching blues scale (the Dorian Blues 
scale) which adds a flattened fifth.
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Sus6/9 Pentatonic scale and the B. B. King blues box
The Sus6/9 Pentatonic scale is one of the modes of the standard Pentatonic 
scale:  an  A Sus6/9 Pentatonic  scale  contains  the  same notes  as  a  D Major 
Pentatonic scale, and can be converted into an A Sus6/9 Blues scale with the 
addition of a flattened fifth:

D Major Pentatonic

9
D

E

F#

A

B

D

E

F#

A

B

D

E

A Sus6/9 Pentatonic

9
D

E

F#

A

B

D

E

F#

A

B

D

E

A Sus6/9 Blues

8

D

Eb

E

F#

A

B

D

Eb

E

F#

A

B

D

Eb

E

This particular shape is interesting, because the notes on the top three strings 
correspond to a shape that B. B. King used, which has become known as the 
B. B. King blues box.

A Blues Box

9 E

F#

A

B

D

Eb

E

This shape is particularly useful for blues solos, because it contains notes that 
are not in the standard Minor Blues scale and which add color to that scale: 
specifically the second (or ninth) note (B in this case) and the sixth note (F# in 
this case). In addition, these two notes can also be bent by a semitone to add 
two notes from the standard Minor Blues scale: bending B to C in this case 
gives  us  a  minor  third,  and  bending  F#  to  G  gives  us  a  minor  seventh. 
Bending also gives us other notes:  the second note (B) can be bent by two 
semitones to add a major third (C#) or by three semitones for a fourth (D), and 
the sixth note (F#) can be bent by two semitones to add a major seventh (G#), 
which you might use over an E chord. The minor third and minor seventh of 
the standard Minor Blues scale can also be added as fretted notes:
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A Blues Box

9 E

F#

A

B

D

Eb

E

C

G

You can use  the  B.  B.  King blues  box with  blues  songs  that  use  major  or 
dominant  chords,  but  you  should  generally  avoid  using  it  with  minor 
progressions: in an A minor blues with Am, Dm, and Em chords the F# will 
clash with the F natural of Dm.

Fretspace for advanced players
If you are an advanced player, you can use Fretspace to explore additional 
chords and scales. You might want to learn altered dominant chords, and your 
next step after the Major scale (and its modes) might be the Melodic Minor 
scale and its modes.

Melodic Minor and other scales
Use Fretspace to create your own chart with the following shapes.
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The  seventh  mode  of  the  Melodic  Minor  is  the  scale  that  jazz  guitarists 
commonly play over an altered dominant chord. An Altered scale is the same 
as a Melodic Minor scale that is a semitone higher.
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Other useful scales include: the Harmonic Minor and its modes, the Harmonic 
Major and its modes, the Diminished scale, the Whole-Tone scale, and Bebop 
scales.  You might  also  want  to  experiment  with  exotic  scales,  such  as  the 
Double Harmonic scale or the Neapolitan scales.

Bebop scales
Bebop scales are eight-note scales that have a chromatic passing note, typically 
between the minor seventh and root of the scale, or between the fifth and sixth 
if  there  isn’t  a  minor  seventh.  This  additional  note  is  helpful  when 
improvising, because it  makes it  easy to outline chord tones:  if  you start a 
Bebop scale with a chord tone, every second note in the scale will also be a 
chord tone.  For  example,  if  you play  an  ascending Bebop Dominant  scale 
starting  on  the  root,  successive  alternate  notes  will  fall  on  the  third,  fifth, 
seventh, and octave of a dominant seventh chord: G, B, D, F, and G in the case 
of the G Bebop Dominant scale. The G Bebop Dominant scale is identical to a 
G  Mixolydian  scale  with  the  addition  of  a  chromatic  passing  note  (F#) 
between the seventh note (F) and the root (G):
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Arpeggios
If you feel that your playing is too scalar, you can break up scale runs by using 
arpeggio shapes, which contain larger intervals and emphasize chord tones. 
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You can use Fretspace to create charts of common arpeggios, such as m7, 7, 
and maj7 arpeggios.

Unusual tunings
Alternatively, if you are interested in unusual guitar tunings, such as Fourths 
or  “New Standard Tuning” (see  6-string  tunings  on  page  42),  you can use 
Fretspace to explore them!

Fretspace for non-guitarists
Fretspace can be used to explore chords and scales on any fretted instrument. 
This manual mostly uses examples from standard guitar tuning, but you can 
make up your own examples for other instruments. Here are some ukulele 
chord shapes.
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Bm7
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If you play ukulele, you could use Fretspace to create your own version of this 
chart, and print it out to use while practicing.

Here are the five main pentatonic ukulele scale shapes.
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If you play a different instrument, you can use Fretspace to create chord and 
scale charts for that instrument.
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Chapter 1: Documents

Managing documents
Options for managing documents can be found in the File  menu. These are 
standard options that behave the same way in most Mac programs.

Creating a new document
Select New from the File menu (or use the keyboard shortcut ⌘N) to create a 
new document.

Opening an existing document
Select  Open…  from  the  File  menu  (shortcut:  ⌘O)  to  open  an  existing 
document.  Alternatively,  select  Open Recent  from the  File  menu to  open a 
recent document.

Closing and saving documents
Select Close from the File menu (shortcut: ⌘W) to close a document. Fretspace 
will prompt you if you have unsaved changes. To close all documents, hold 
down the Option key and select Close All from the File menu (shortcut: ⌥⌘W). 
An alternative way of closing a document is to click on the red button at the 
top left  of  the window. If  a window contains several  tabs,  select  Close Tab 
(shortcut: ⌘W) to close the document that is currently displayed. You can also 
close tabs by clicking on the x icon on the left of a tab.

Select Save from the File menu (shortcut: ⌘S) to save a document. If you have 
not previously saved this document, Fretspace will  display a dialog asking 
you for a file name and a location to save the document.

Like most  other  modern Mac programs,  Fretspace automatically saves any 
documents that you are working on, so there is no need for you to keep saving 
them manually. However, saving a document manually creates a “version” of 
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the document. You can revert to previous versions using the Revert command 
(see Reverting a document, below).

Duplicating documents
Select Duplicate… from the File menu (shortcut: ⇧⌘S) to duplicate the current 
document. To save the current document under a new name, hold down the 
Option key and select Save As… (shortcut: ⌥⇧⌘S) from the File menu.

Renaming a document
Select  Rename…  from the  File  menu to  rename a  document.  You can also 
rename a document by clicking on its name in the title bar of the window and 
typing a new name in the popup dialog.

Moving a document
Select  Move To…  from  the  File  menu  to  move  a  document  to  a  different 
location. You can also move a document by clicking on its name in the title bar 
of the window and choosing a new location in the popup dialog.

Reverting a document
Select Revert To from the File menu if you wish to revert to an earlier version 
of  a  document.  You can easily  revert  to  the last  saved version,  or  the last 
opened  version,  or  you  can  choose  Browse All Versions…  to  revert  to  any 
previous version.

Printing documents
Setting page size, orientation and scale
Select Page Setup…  from the File  menu (shortcut: ⇧⌘P) to define the size, 
orientation, and scale of a printed page or exported PDF file.

This is an important command because it determines how much content you 
can fit on a page, and how large the content will be when it is printed. You 
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might want the content to be larger, so that you can read it more easily, or you 
might want it to be smaller, so that you can fit more on a page.

Paper Size should be the size of paper that you intend to print on.

Orientation allows you to choose whether to print in portrait orientation 
(this is the first option and is the normal way of orienting a page, so that 
its height is greater than its width) or landscape orientation (this is the 
second option: the page is turned on its side so that its width is greater 
than its height).

Scale defines the scale at which content is printed. Choose a smaller scale 
if you wish to fit more content on a page, or a larger scale if you want the 
content to be larger.

If you want to print at a larger scale, and you normally print on A4 paper, you 
could increase the scale to 140% and choose landscape orientation. This will fit 
the same number of items on a line, but there will be fewer lines on a page.

Alternatively, if you have an A3 printer, you could select A3 paper size and 
140% scale. This will format pages so that they look identical to A4 pages at 
100% scale, except that the items on the printed page will be larger.1

The size, orientation, and scale that you select determine the way that charts 
are printed,  and they also determine the way that  charts  are displayed on 

1. If you want to print at a smaller scale, you might logically choose A5 paper and set the scale to 
70% (half of 140%). However, you might find that this causes charts to be reformatted, because the 
imageable width of A5 paper is slightly less than half the imageable width of A3 paper when 
borders are added. If this happens, try using a slightly smaller scale, such as 69%.
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screen when Fixed Layout (the default layout option) is selected in the Chart 
menu. With this option selected, charts are divided into separate pages that 
are laid out identically on screen to the way that they will be printed. If you 
want to fit more content on a page, and you don’t mind the content being 
smaller when it is printed, choose a scale that is smaller than 100% and see 
how the content is formatted in Fretspace (with Fixed Layout selected). Adjust 
the scale until you are happy with the way that the content is formatted.

Printing a chart
Select Print… from the File menu (shortcut: ⌘P) to print the current chart. The 
printed chart will look the same as it does on screen (if you have the Fixed 
Layout option selected) except that boxes that are drawn in blue on screen (to 
show that they are selected) will be printed in black, and paragraph symbols 
are not printed. The Print dialog shows a preview of what the printed chart 
will look like.

You can print multiple copies of a chart by typing the number of copies that 
you wish to print in the Copies field of the dialog.



Chapter 2 Windows 29

Chapter 2: Windows

Window areas
The Charts panel, main area, and Inspector panel

Fretspace windows are divided into three main areas:

1. The left of the window contains the Charts panel, which lists all the charts 
that are in the current document. You can add new charts by clicking on 
the + (plus) button at the bottom of this panel, and you can delete charts 
by clicking on the -  (minus) button at the bottom of the panel. You can 
switch  between  charts  by  selecting  the  chart  that  you  wish  to  be 
displayed. You can also reorder charts by dragging them to a different 
position within the Charts panel.
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2. The area in the middle of  a  window displays charts  containing chord, 
scale, and arpeggio shapes (blue indicates a selected shape).

3. An Inspector panel to the right of the window displays information about 
charts and boxes, and allows you to change their properties.
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Toolbar
Fretspace displays a toolbar near the top of the window.

This contains tools that allow you to perform common operations. You can 
hide the toolbar by selecting Hide Toolbar (shortcut ⌥⌘T) from the View menu, 
and you can show it again by selecting Show Toolbar (same shortcut). You can 
also  customize  the  toolbar  by  selecting  Customize Toolbar…  from  the  View 
menu.

Title bar
The top of a window contains a title bar which displays the title of the current 
document. If you click on this, it displays a pop-up dialog that allows you to 
rename the current document or move it to a different location.

The title bar also displays information about whether a document has been 
edited since it was last saved.

At the left of the title bar are three standard window buttons: a red button 
which closes the window, an amber button which minimizes it, and a green 
button  that  switches  into  full-screen  mode  (or  zooms  the  window  to 
maximum size if you hold down the Option key).

Full-screen mode
If  you  wish  to  use  Fretspace  in  full-screen  mode,  select  Enter Full Screen 
(shortcut: ^⌘F) from the View menu or click on the green button at the top left 
of the window. This resizes the current window so that it takes up the whole 
of the screen, with the menu bar hidden unless you move the mouse to the top 
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of the screen. You can exit from full-screen mode by selecting Exit Full Screen 
(same shortcut: ^⌘F) from the View menu after moving the mouse to the top 
of the screen, or by pressing the Escape key, or by clicking a second time on 
the green window button (after moving the mouse to the top of the screen).

Managing windows
Minimizing windows
Select  Minimize  from  the  Window  window  (shortcut:  ⌘M)  to  minimize 
windows.  A minimized  window  is  shrunk  and  placed  in  the  Dock.  An 
alternative way to minimize windows is to click on the amber button near the 
top left of the window.

Zooming windows
Select Zoom from the Window menu to zoom windows. Zooming a window 
sets it to its maximum size, or returns it to its previous size if you select it a 
second time. An alternative way to zoom windows is to hold down the Option 
key and click on the green button near the top left of the window.

Switching windows
You can switch between windows by selecting them from the Window menu. 
You can also cycle between windows by pressing ⌘~ .

Switching tabs
If a window contains several tabs, you can switch between them by pressing 
^⇥ (Control-Tab) to move to the next tab or ^⇧⇥ (Control-Shift-Tab) to move to 
the previous tab.
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Chapter 3: Charts

Managing charts
A Fretspace document contains charts of chord, scale, and arpeggio shapes. 
You can manage charts using the Charts panel on the left of the window, or by 
selecting options from the Chart menu, or by changing properties in the Chart 
section of the Inspector panel.

Creating a new chart
You can create a new chart by selecting New Chart (shortcut: ⌥⌘N) from the 
Chart menu, or by clicking on the + button at the bottom of the Charts panel.

Naming a chart
You will generally want to give charts a descriptive name, so that you can 
identify them easily. You can do this by clicking on the name of the chart in the 
Charts panel, after first selecting it, or by entering a name in the Name field of 
the Chart section of the Inspector panel.

If you don’t name charts, Fretspace numbers them as “Chart 1”, “Chart 2” etc. 
according to their order within the Charts panel.

Reordering charts
You can reorder charts by dragging them to a different position in the Charts 
panel.

Deleting a chart
You can delete a chart by selecting it and clicking on the - (minus) button at the 
bottom  of  the  Charts  panel,  or  by  choosing  Delete  from  the  Edit  menu 
(shortcut: Backspace).
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Copying and pasting charts
Use the standard Cut (shortcut: ⌘X), Copy (shortcut: ⌘C), and Paste (shortcut: 
⌘V) commands in the Edit menu to cut, copy, and paste selected charts. You 
can  also  copy  charts  by  dragging  them  onto  the  Charts  panel  of  another 
document.

Duplicating charts
Select Duplicate from the Edit menu (shortcut: ⌘D) to duplicate selected charts. 
Another way to duplicate a chart is to click on it in the Charts panel and drag 
it while holding the Option  key. A plus sign is displayed next to the mouse 
cursor to indicate that the chart will be duplicated instead of moved.

Adding content
The second section of the Chart menu contains commands for adding content 
to  a  chart.  There  are  options  for  adding  boxes,  chord  shapes,  scale  and 
arpeggio  shapes,  and  paragraph  breaks.  Some  of  this  functionality  is  also 
duplicated by tools in the toolbar.

Boxes and other content are inserted after the currently selected item, or after 
the last selected item if more than one item is selected, or at the end of the 
chart if no items are currently selected.

Adding a box
Select Insert Box  from the Chart  menu (shortcut: ⌘B) to add an empty box. 
Alternatively, click on the Insert Box tool in the toolbar.
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Boxes represent areas of the fretboard, with vertical lines representing strings 
and horizontal lines representing frets. A box which starts at the first fret has a 
thick line above it which represents the nut (at the start of the fretboard). The 
second horizontal line is  the first  fret  at  which notes can be fretted. A box 
which starts after the first fret displays a fret number to the left of (and above) 
the second line. There are 24 possible fret positions, but this is a maximum 
number, since many instruments contain fewer than 24 frets.

3

The number of  frets  and strings in  a  newly added box depends upon the 
currently selected tuning. For standard guitar tuning, Fretspace inserts boxes 
that contain six strings and four frets starting at the first fret.

Adding chords

Select Insert Chord from the Chart menu (shortcut: ⌘K) to add a chord shape. 
Alternatively, click on the Insert Chord tool in the toolbar.

Fretspace  displays  a  chord  picker  that  allows  you to  choose  virtually  any 
chord that can be played in the current tuning. The chord picker is described 
in detail in Chapter 5: Chord Picker on page 69.

Adding scales and arpeggios
Select Insert Scale / Arpeggio from the Chart menu (shortcut: ⌘L) to add a scale 
or arpeggio shape. Alternatively, click on the Insert Scale / Arpeggio tool in the 
toolbar.
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Fretspace  displays  a  scale  and  arpeggio  picker  that  allows  you  to  choose 
almost any scale or arpeggio that can be played in the current tuning. The 
scale and arpeggio picker is  described in detail  in Chapter  6:  Scale/Arpeggio 
Picker on page 77.

Adding a paragraph break
Press Return  or select Insert Break  from the Chart  menu to add a paragraph 
break. This ends the current section of boxes, so that the next box after a break 
is displayed on a new line.

Paragraph breaks are normally invisible,  unless they are selected, in which 
case they are drawn with a paragraph symbol (¶).

Selecting content
You can select boxes and other content that you wish to edit,  copy, delete, 
move, or duplicate. Selected boxes are drawn in blue instead of black, and 
selected paragraph breaks are drawn with a blue paragraph symbol instead of 
being invisible.

Selecting content with the mouse
You can select boxes and other content by clicking on them. This will normally 
deselect  the previously selected item or  items,  but  you can select  multiple 
items by holding down the Shift or Command key while clicking. Command-
clicking selects  item you click  on in  addition to  previously  selected items. 
Shift-clicking is similar, except that it also selects all items between the clicked 
item and the most recently selected item.

You can also select multiple items by dragging a rectangle around them as you 
would in the Finder. Once again, you can use the Shift or Command key to add 
these items to a previous selection.

Selecting content with arrow keys
You can also select content using arrow keys.
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← (left-arrow) selects the item before the currently selected item, or after 
the most recently selected item if there is more than one selected item, or 
the last item in a chart if there is no currently selected item.

→ (right-arrow) selects the item after the currently selected item, or after 
the most recently selected item if there is more than one selected item, or 
the first item in a chart if there is no currently selected item.

↑ (up-arrow) selects the item above the currently selected item or above the 
most recently selected item if there is more than one selected item, or the 
last item in a chart if there is no currently selected item.

↓ (down-arrow) selects the item below the currently selected item or below 
the most recently selected item if there is more than one selected item, or 
the first item in a chart if there is no currently selected item.

If you hold the Shift key while pressing one of the arrow keys, Fretspace adds 
new items to the current selection. If  you hold down the Option  key while 
pressing one of the arrow keys, the selection is moved (or extended) to the 
start of the chart (Option ↑), end of the chart (Option ↓), start of the current line 
(Option ←), or end of the current line (Option →).

Selecting all content
Choose Select All from the Edit menu (shortcut: ⌘A) to select all content in a 
chart.

Deleting content
You can delete selected content by pressing Backspace or by choosing Delete 
from the Edit menu.

Deleting a paragraph break
You  can  delete  paragraph  breaks  in  the  same  way  that  you  delete  other 
content. Select the break by clicking on it or by using arrow keys to select it, 
then press Backspace or choose Delete from the Edit menu.
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Moving content
You can move items within a chart by clicking on them and dragging them to 
a new position. Fretspace displays an insertion point that shows where the 
content will be positioned if you stop dragging.

Duplicating content
Duplicating items with Duplicate
Select Duplicate from the Edit menu (shortcut: ⌘D) to duplicate selected items.

Duplicating items with Option-drag
Another way of duplicating items is to click on them and drag them while 
holding the Option key. A plus sign is displayed next to the mouse cursor to 
indicate that the items will be duplicated instead of moved.

Copying and pasting content
Use the standard Cut (shortcut: ⌘X), Copy (shortcut: ⌘C), and Paste (shortcut: 
⌘V) commands in the Edit menu to cut, copy, and paste selected items.

Copying and pasting within Fretspace
When you paste items within Fretspace, they are pasted after the currently 
selected item, or after the last selected item if more than one item is selected, 
or at the end of the chart if no item is currently selected.

Copying and pasting to other applications
You can copy and paste boxes from Fretspace to other applications. In this case 
the boxes are copied as vector graphics in PDF format, which means that they 
can be rescaled in other applications (such as a word processor or page-layout 
program) without being degraded. Most of the chord and scale shapes in this 
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manual were copied directly out of Fretspace and pasted into Nisus Writer 
(where they were rescaled).

Exporting content
Exporting a chart
You can export a chart in PDF format by choosing Export Chart from the File 
menu. The PDF page size is determined by the Page Setup dialog. See Setting 
page size, orientation and scale on page 26.

Fretspace will ask you to choose a folder where the exported file will be saved. 
The  file  is  named  after  the  chart  title,  except  that  spaces  are  replaced  by 
underscores and forward slashes (which are not valid within file names) are 
replaced by percent symbols. If you export two charts with the same name, or 
export the same chart twice, Fretspace will append an underscore followed by 
a digit to the second file (e.g. a second “Guitar Scales” PDF will be named 
Guitar_Scales_2.pdf).

Exporting boxes
You can export boxes as PDF, PNG, or JPEG graphics. Select the boxes that 
you wish to export, and choose Export Boxes… from the File menu. The menu 
title  specifies the number of  boxes that are currently selected (e.g.  Export 4 
Boxes…)

Fretspace will display a dialog that allows you to choose a file format. This 
may be PDF, which is a vector format that is resolution-independent and can 
be used in word processors and layout programs, or it can be a bitmap format 
such as PNG or JPEG. If  you choose a bitmap format,  you can change the 
bitmap resolution from 72 pixels per inch (standard resolution) to 144 pixels 
per inch (high resolution) or some other value. If you choose JPEG format, you 
can also specify the quality of the JPEG image: the default quality is 85%, but 
choosing a lower quality will create smaller files.
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Once you have chosen a format and other options, Fretspace will ask you to 
choose a folder where the exported images will be saved. Images are named 
after  the  box  label,  except  that  spaces  are  replaced  by  underscores  and 
forward  slashes  (which  are  not  valid  within  file  names)  are  replaced  by 
percent symbols. If you export two boxes with the same name, Fretspace will 
add an underscore followed by a digit to the second file name (e.g. a second 
“E7” PNG file will be named E7_2.png).

Undo and redo
Undoing changes
Select Undo from the Edit menu (shortcut: ⌘Z) if you wish to undo changes 
that you have made. Almost anything that you do in Fretspace can be undone, 
and you can undo multiple changes by choosing Undo repeatedly. The title of 
the Undo option normally identifies the operation that can be undone: if you 
delete a chart, it will say Undo Delete Chart; if you duplicate a box it will say 
Undo Duplicate Box (and so on).

Redoing changes
Select  Redo  from  the  Edit  menu  (shortcut:  ⇧⌘Z)  if  you  wish  to  redo  an 
operation that  you have previously undone.  As with Undo,  the title  of  the 
Redo option normally identifies the operation that can be redone.
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Chart tunings
Charts have a tuning which identifies the instrument and tuning for which 
they are intended. When you add a box, or chord, or scale, or arpeggio to a 
chart, it will default to this tuning. It is possible to have a chart that contains 
multiple  tunings,  and there  are  a  few cases  where  this  can  be  useful,  but 
generally  it  is  less  confusing  for  all  boxes  within  a  chart  to  use  the  same 
tuning.

Fretspace initially defaults to standard guitar tuning. If you normally use a 
different  guitar  tuning,  or  play  a  different  instrument,  use  the  the  Default 
Tuning popup in the General section of the Preferences dialog to select your 
preferred tuning.

Changing a chart tuning
When you create a new chart, it uses the default tuning (as specified in the 
General section of the Preferences dialog). You can use the Tuning popup in the 
Chart section of the Inspector panel to change the chart tuning.

The  Tuning  menu  groups  tunings  into  different  sections  according  to  the 
number  of  strings  (or  pairs  of  strings)  that  are  used.  Within  each  section, 
tunings are ordered alphabetically.

Fretspace provides the following pre-defined tunings:



42 Chapter 3 Charts

3-string tunings
Trichordo Bouzouki : standard DAD tuning for bouzouki with three pairs of 
strings

4-string tunings
Banjo : standard DGBD tuning for  the first  four strings of  a  five-string 
banjo. Banjos commonly have five rather than four strings, and the fifth 
string  starts  five  frets  above  the  other  strings.  Since  it  is  usually  not 
fretted, banjo shapes are typically shown with four strings rather than five 
strings.2

Bass : standard EADG tuning for bass guitar.

Greek Bouzouki : standard CFAD tuning for Greek bouzouki.

Irish Bouzouki : standard GDAD tuning for Irish bouzouki.

Mandolin : standard GDAE mandolin tuning.

Ukulele : standard GCEA ukulele tuning.

5-string tunings
Bass: BEADG : BEADG tuning for five-string bass guitar.

Bass: EADGC : EADGC tuning for five-string bass guitar.

6-string tunings
Guitar : Standard EADGBE guitar tuning.

2. If you wish to use banjo shapes that include all five strings, starting at the fifth fret or higher, 
you can do this by creating a Banjo tuning with D4 as the pitch of the fifth string. The actual pitch 
of the fifth string is G4, but since the string starts at the fifth fret, D4 will give the correct note 
values for chord shapes in which the fifth string is fretted. If the fifth string is not fretted, you can 
either use a four-string tuning or create another five-string tuning in which the fifth string is G4 
(but don’t place any dots on it). Fretspace allows you to mix boxes with different tunings on the 
same  page.  Normally  this  would  be  confusing,  but  this  is  one  situation  where  you  might 
legitimately wish to do so.



Chapter 3 Charts 43

Guitar: DADGAD : DADGAD guitar tuning.

Guitar: Double Drop D : DADGBD guitar tuning (first and last strings are 
dropped two semitones from E to D).

Guitar: Drop D : DADGBE guitar tuning (bass string is dropped to D).

Guitar: Fourths  :  EADGCF guitar  tuning  (all  strings  are  tuned a  fourth 
apart).

Guitar: NST  :  CGDAEG  guitar  tuning.  NST  stands  for  “New  Standard 
Tuning”.  This  tuning  was  invented  by  Robert  Fripp  (King  Crimson 
guitarist)  and  taught  in  Guitar  Craft  and  Guitar  Circle  courses.  Most 
strings are tuned a fifth apart, except for the first string, which is tuned a 
minor third from the second string.

If you use a tuning that isn’t listed here, you can add a new tuning using the 
Tunings section of the Preferences dialog (see Tunings Preferences on page 84).

If you change the tuning of a chart that already contains content, Fretspace 
will change the boxes in the chart to reflect the new tuning, and any existing 
chord and scale  shapes  might  or  might  not  make much sense  in  the  new 
tuning (depending on how similar the tunings are).

On the other hand, if you paste a box whose tuning does not match the chart 
tuning, Fretspace will  assume that you know what you are doing and will 
allow you to have boxes with different tunings in the same chart. Boxes whose 
tuning doesn’t match the chart tuning will display their own Tuning popup, so 
you can change the tuning to match the chart tuning if you wish to.

Chart display options
The options that follow the Tuning popup in the Chart section of the Inspector 
panel can be used to change the way that a chart and its content are displayed. 
Except for Layout these options also change the way that charts are printed, so 
that what you see on screen matches what you see when a chart is printed. 
These options are also found in the Chart menu.
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Show Title
Selecting this option causes the title of a chart to be displayed at the top of a 
chart. This is a useful way of identifying charts when they are printed. When 
titles are shown, they can also be edited directly on the page (as well as in the 
Name field of the Inspector panel and in the Charts panel).

Another way to select this option is to choose Show Title from the Chart menu 
(shortcut: ⌘1).

Show Notes
It is often useful to see which notes are used in a chord or scale or arpeggio. 
The Show Notes option causes notes to be displayed underneath a chord box, 
or inside the dots of a scale or arpeggio box. If you previously selected Show 
Degrees or Show Root, these options will be deselected, since it is not possible 
to show notes and degrees simultaneously.
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Another  way to  select  this  option is  to  choose  Show Notes  from the  Chart 
menu (shortcut: ⌘2).

Show Degrees
Instead of displaying notes, you might choose to display the chord or scale 
degrees. This displays the root and other musical degrees (second, third etc.) 
of a chord, scale, or arpeggio. Chord degrees are displayed underneath the 
box, while scale and arpeggio degrees are displayed inside the note dots. If 
you  previously  selected  Show Notes  or  Show Root,  these  options  will  be 
deselected.
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Another way to select this option is to choose Show Degrees from the Chart 
menu (shortcut: ⌘3).

Show Root
This option is similar to Show Degrees, except that it only indicates the root of 
a shape. If you previously selected Show Notes or Show Degrees, these options 
will be deselected.
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Another way to select this option is to choose Show Root from the Chart menu 
(shortcut: ⌘4).

Color Root Notes
This option identifies root notes by coloring them red. In contrast to the Show 
Root option, it can be combined with Show Degrees or Show Notes.
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Another way to select this option is to choose Color Root Notes from the Chart 
menu (shortcut: ⌘5).

Color Selected Notes
This option can be used in conjunction with the Select Notes option in the Box 
section of the Inspector panel. It allows you to color notes other than the root 
note (e.g. flattened notes in Blues scales).

Another way to select this option is to choose Color Selected Notes from the 
Chart menu (shortcut: ⌘6).
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A Minor Blues
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Show Fingering
This  option  shows  the  fingering  for  a  chord,  scale,  or  arpeggio  shape. 
Fretspace calculates fingerings automatically, but you can change this to reflect 
your own preferred fingering by selecting Edit Fingering… from the Box menu 
(see Editing fingering on page 65).

In the case of  chord shapes,  where notes  and degree values are  displayed 
beneath a box, it is possible to display fingerings alongside notes or degrees. 
In the case of scales and arpeggios, fingerings are not displayed when notes or 
degrees are displayed.
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Another way to select this option is to choose Show Fingering from the Chart 
menu (shortcut: ⌘7).
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Layout
The  final  option  in  the  Chart  section  of  the  Inspector  panel  allows  you  to 
choose between Fixed and Flexible layout. Fixed layout uses the same layout 
that is used when a chart is printed, so that what you see on screen matches 
what you will see on printing. With this layout option, charts are displayed 
within one or more pages that match the size, scale, and orientation of printed 
pages. (See Setting page size, orientation and scale on page 26.)

Flexible  layout is  an alternative layout option that  may be more useful  for 
viewing charts on screen. With flexible layout, charts are displayed within a 
single page that resizes to fit the size of the window on screen—if you make a 
window smaller or larger, the content will be rearranged to fit the new size. 
Note that this has no effect on the way that charts are printed. If you intend to 
print a chart, you might wish to switch back to Fixed layout in order to see 
how the chart will appear when it is printed.

Another way to select this option is to choose Flexible Layout or Fixed Layout 
from the Chart menu (shortcut: ⌘8).
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Chapter 4: Boxes

Working with boxes
Fretboard boxes are a standard way of representing chord, scale, and arpeggio 
shapes for guitars and other fretted instruments. A box contains a number of 
vertical lines, which represent the strings of the instrument (six on a standard 
guitar), and a number of horizontal lines which represent the frets. If a box 
starts  with  the  first  fret,  there  is  a  thick  line  at  the  top  of  the  box  which 
represents the nut of  the instrument—this is  a  piece of  hard material  over 
which strings run from the headstock onto the fretboard. When looking at a 
box, you should imagine that the instrument is being held vertically and there 
is an imaginary headstock just above the nut. If a box starts further along the 
fretboard, the nut is not shown, and there is a thin horizontal line at the top of 
the box which represents the previous fret. The first actual fret of the box is 
indicated by a fret number to the left of the box.

3

Boxes normally contain dots, which represent the notes that are played. There 
are  two  types  of  dot:  open  dots—which  represent  open  notes—and  filled 
dots—which represent fretted notes. Open notes are strings that are played 
without being fretted. These are represented by an open circle that is drawn 
above the nut and is typically smaller than a filled dot (unless it also contains 
a note or degree value). Fretted notes are notes that are fretted by placing a 
finger just before a fret, so that the vibrating length of the string is shortened 
and the pitch is changed. These are represented by filled (normally black) dots 
that are placed before the line that represents the fret  at  which the note is 
played.
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C G

3

Types of box
There are two main types of box within Fretspace: chord boxes and scale/
arpeggio  boxes.  The  essential  difference  between  chords  and  scales  (or 
arpeggios)  is  that  chord  notes  are  played  simultaneously  (or  almost 
simultaneously) so that it is not possible to have more than one chord note on 
the same string, while scale and arpeggio notes are played sequentially, so that 
it is possible to have several scale or arpeggio notes on the same string. If you 
add a dot to a chord shape, Fretspace will therefore remove any dots that were 
previously used on the same string, but if you add dots to a scale or arpeggio 
shape, Fretspace will not remove any existing dots.

Another difference between chord and scale/arpeggio boxes is that Fretspace 
uses a smaller font for scale/arpeggio names, since they are often longer than 
chord names.

Chord boxes can be converted into scale/arpeggio boxes and vice versa (see 
Changing the type of a box below).

MIDI playback
Click on the Play tool in the toolbar, or press Space, to play the notes in any 
box that  is  currently selected.  The Play  tool  changes to  a  Stop  tool  during 
playback: click a second time (or press Space a second time) to stop playback.

Hold down the Option key if you want to play arpeggiated notes in a chord, or 
if you want to play a scale or arpeggio starting from (and ending on) its root 
note. You can also play chords and scales/arpeggios in the chord and scale/
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arpeggio pickers by clicking on the Play/Stop buttons (or pressing Space) in 
these dialogs.

The  Preferences  dialog  can  be  used  to  configure  playback  preferences, 
including  whether  scales  and  arpeggios  are  played  in  ascending  or 
descending  order  (or  both)  and  the  tempo  at  which  they  are  played  (see 
Playback Preferences on page 88).

Editing boxes
There are various ways of editing boxes in Fretspace, either by adding and 
removing notes, or by changing a box in some other way. In order to edit a box 
you must first select it, so that it is displayed in blue. Some options can be 
used to edit multiple boxes at the same time.

Anything that you do to a box can be undone. Select Undo from the Edit menu 
(shortcut: ⌘Z) to undo a change, or select Redo  (shortcut: ⇧⌘Z) to redo a 
change. You can undo and redo multiple operations.

Changing the type of a box
Use the Type  popup in the Box  section of the Inspector  panel to change the 
type of a box, or select Change Type from the Box menu (shortcut: ⌘T).

When you change a chord box to a scale/arpeggio box, the chord is converted 
into an arpeggio (or broken chord) and the notes are unchanged. When you 
convert a scale/arpeggio box into a chord box, Fretspace removes all but the 
first  dot  on  a  string.  See  Completing  a  shape  (below)  for  information  on 
converting chords into full arpeggio shapes.

Adding and removing notes
You  can  add  notes  to  a  box  by  clicking  on  one  of  the  vertical  lines  that 
represent strings, just before one of the horizontal lines that represent frets—or 
above the thick horizontal line that represents the nut if you wish to add an 
open note. Fretspace adds a dot to the box at the place where you clicked. If 



52 Chapter 4 Boxes

you are editing a chord box, Fretspace will remove any other dots that are on 
the same string as the dot you added.

To remove notes, simply click a second time on an existing dot.

If you are adding or removing notes in a scale/arpeggio box, you can hold 
down Option in order to add or remove equivalent notes at other points in the 
scale or arpeggio. For example, you could convert an A Minor Pentatonic scale 
into an A Minor Blues scale by holding Option  while clicking to add an Eb 
note.

Removing all the notes in a box
Select Clear from the Box menu (shortcut: ⌘Backspace) to remove all the dots 
in a box. Another way to do this is to click on the Clear tool in the toolbar.

Completing a shape
Select Complete from the Box menu (shortcut: ⌘Return) to complete a shape 
by adding notes. Alternatively, click on the Complete tool in the toolbar.

In the case of scales and arpeggios, Complete extends the sequence above and 
below  existing  notes,  and  adds  missing  notes  within  the  sequence.  With 
chords, it duplicates notes on other strings, and adds fifths to major/minor 
triads and dominant/minor sevenths.  Here are some examples of two-note 
chords that have been completed in this way:

G

G B

G

G B D G B G

Am

A C

Am/E

E A E A C E
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If a box is completely empty, so that there are no notes to extend or duplicate, 
Complete adds open or barred notes on each string depending on whether the 
box is in open position (the first fret is 1) or not (the first fret is 2 or higher). If 
the box is a scale/arpeggio box it then duplicates these notes at other positions 
to create an arpeggio or scale. In standard guitar tuning (which contains the 
notes  of  a  standard pentatonic  scale)  this  will  create  a  G Major  (E  Minor) 
Pentatonic scale in an open-position box (first fret is 1), or a C Major (A Minor) 
Pentatonic scale when the first fret is 5.

The Complete command can also be used to convert chords into arpeggios. If 
you want to convert a chord into an arpeggio that contains the chord notes in 
a  complete  sequence,  change  the  box  Type  to  Scale/Arpeggio  and  then 
Complete it: in guitar tuning, a first-position C chord with five notes (C-E-G-C-
E)  will  be converted into a  full  arpeggio shape with all  the notes  that  are 
playable in this position (E-G-C-E-G-C-E-G).

C

C E G C E
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C/E
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E
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E

G

Complete can also be used to draw a barred chord in an empty box: set the first 
fret of the box to be greater than 1 and then use Complete to draw a bar at that 
fret position (if the box is in open position, Complete will add open dots, but 
Move Dots Down will convert these into a bar at the first fret).

5

Am7/11

5

A D G C E A
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Naming boxes
Fretspace automatically calculates the name of any shape that you draw or 
create—this  is  a  great  way to identify shapes that  you might  already play 
without knowing exactly what they are called!

However, it is possible for the same shape to have different names depending 
on how it is used. Most guitarists know that an Am7 shape can also be used to 
play a C6 chord. In much the same way, a C major scale shape can be used to 
play a variety of different modes, such as A Aeolian (a natural minor scale) D 
Dorian (another minor scale) or G Mixolydian (a dominant scale).

In cases where a shape has different names, you can use the Name control in 
the Box section of the Inspector panel to choose between different names that 
can be applied.

Am7

A E G C E

C6

A E G C E

If you wish to use a name that Fretspace doesn’t offer, you can type a name 
into the text part of the Name control, or you can click on the name that is 
displayed  above  the  box  and  type  a  new  name  there.  Once  you  do  this, 
Fretspace hands over responsibility for naming this box and will no longer 
calculate names for it, even if you subsequently change it to a different shape, 
although it will take the first letter of the name that you have assigned as a 
hint when it calculates the root of the shape. If you wish to go back and have 
Fretspace calculate the name automatically, you do this by deleting whatever 
name you previously typed.

Box tunings
Normally, all the boxes in a chart use the same tuning, but occasionally you 
might  want  to  have  boxes  with  different  tunings  in  the  same  chart  (see 
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footnote 2 on page 42 for an example of when this might be useful). If you 
want to add boxes with a different tuning, you can create them in a chart that 
has that tuning and then copy them into a chart with the other tuning.

If  a  chart  contains  boxes  with  different  tunings,  Fretspace  will  display  a 
second Tuning popup in the Box section of the Inspector panel.

See Chart tunings on page 41 for more information on tunings.

Changing the size and position of a box
Boxes represent a view of part of the fretboard. You can change the first fret of 
a box and the number of frets that it contains. Fretspace allows for 24 possible 
frets—so the maximum size of a box that starts at the first fret is 24 frets. (Most 
instruments have fewer than 24 frets.)

Changing the first fret of a box
Use the First Fret text field in the Box section of the Inspector panel to change 
the first fret of a box, or select Set First Fret… from the Box menu (shortcut: 
⌘[ ). You cannot set the first fret to be greater than the first fretted dot, and the 
last fret within a box cannot be greater than 24.

Changing the number of frets in a box
Use the Number of Frets text field in the Box section of the Inspector panel to 
change the number of frets in a box, or select Set Number of Frets… from the 
Box menu (shortcut: ⌘] ). You cannot set the number of frets to be smaller than 
the number of frets used by fretted dots, and the last fret within a box cannot 
be greater than 24.

Selecting notes in a scale box
Select the Select Notes checkbox in the Box section of the Inspector panel if you 
wish to select scale notes that will  be colored when Color Selected Notes  is 
chosen  in  the  Chart  section  of  the  Inspector  panel  (or  Chart  menu).  This 
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displays a row of buttons that you can use to color specific degrees of a scale, 
such as flattened (blues) notes in Blues scales.

Moving dots
You can create new chords, scales, and arpeggios by moving shapes around 
the fretboard. Fretspace contains a number of commands that allow you to do 
this by moving dots to different strings or to a different fret position. In most 
cases, this results in a shape that is transposed to a different key but contains 
the same chord or scale degrees as the original shape.

Moving dots up
Select  Move Dots Up  from  the  Box  menu  (shortcut:  ⌘↑)  to  move  dots  up 
within a box, so that they are one fret closer to the nut (and one semitone 
lower in pitch). Any notes that are fretted at the first fret will become open 
(unfretted) notes,  so that an F major barred chord will  become an E major 
unbarred chord. It is not possible to move dots up if a box already contains 
open notes.

F E

Alternatively, click on the Move Dots Up tool in the toolbar.

Holding down the Shift key when choosing Move Dots Up (or when clicking on 
the Move Dots Up tool) will allow you to move shapes up by 12 frets. You can 
also use the keyboard shortcut ⇧⌘↑ .
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Moving dots down
Select Move Dots Down from the Box menu (shortcut: ⌘↓) to move dots down 
within a box, so that they are one fret further away from the nut (and one 
semitone higher in pitch). Any open notes will be moved to the first fret, so 
that the open notes of an E major guitar chord will become barred notes in an 
F major chord. It is not possible to move dots down beyond the 24th fret.

E F

Alternatively, click on the Move Dots Down tool in the toolbar.

Holding down the Shift key when choosing Move Dots Down (or when clicking 
on the Move Dots Down tool) will allow you to move shapes down by 12 frets. 
You can also use the keyboard shortcut ⇧⌘↓ .

Moving fretted dots up
Select  Move Fretted Dots Up  from  the  Box  menu  (shortcut:  ⌥⌘↑)  to  move 
fretted dots up within a box.

Alternatively, click on the Move Fretted Dots Up tool in the toolbar.

In contrast to Move Dots Up, this command moves fretted dots while leaving 
open dots where they are, thereby changing the relationship of fretted dots to 
unfretted dots and the type of chord or arpeggio that they represent. It is not 
possible to move dots up if they are fretted at the first fret, since that would 
change their relationship to other fretted dots.
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Moving fretted dots down
Select Move Fretted Dots Down from the Box menu (shortcut: ⌥⌘↓) to move 
fretted dots down within a box.

Alternatively, click on the Move Fretted Dots Down tool in the toolbar.

In  contrast  to  Move Dots Down,  this  command  moves  fretted  dots  while 
leaving open dots where they are, thereby changing the relationship of fretted 
dots to unfretted dots and the type of chord or arpeggio that they represent. 

Moving the fretted dots of a first-position open chord can be used as a way of 
creating unusual open chords that combine open notes with notes that are 
fretted  some distance  from the  first  fret.  This  can  create  chords  that  have 
distinctive intervals and sound different to other types of guitar chord.

As an example, the fretted dots of a C7 guitar chord can be moved down by 
two frets to create a D9 chord. Similarly the fretted dots of a D guitar chord 
can be moved three frets down to create a Dm7 chord.

C7 D9

3

D Dm7

5

Shifting dots left
Select Shift Dots Left from the Box menu (shortcut: ⌘←) to shift dots to the left 
within a box, so that they are moved onto adjacent strings, away from the first 
(rightmost) string.

Alternatively, click on the Shift Dots Left tool in the toolbar.



Chapter 4 Boxes 59

In standard guitar tuning, Shift Dots Left creates a shape that is a fourth (five 
semitones)  lower  in  pitch  than  the  original  shape.  Fretspace  preserves  the 
musical intervals between the notes when dots are shifted in this way, and the 
shape may change as a result, depending upon the current tuning. In standard 
guitar tuning, most strings are tuned to be a fourth (five frets) higher than the 
previous string, but the second string is tuned a major third (four frets) higher 
than the third string. So (for standard guitar tuning) Fretspace preserves the 
distance between notes by moving dots one fret closer to the nut when they 
are moved from the second string to the third string. If you shift the dots of a 
standard D guitar chord by one position to the left, Fretspace creates a chord 
that looks like a standard A chord, although it doesn’t contain a note on the 
first string unless you add it or use the Complete command to do this.

D A

If a tuning contains the same interval between all strings (as is the case with 
standard mandolin tuning) the shape will not change.

It  is  not possible to shift  dots left  if  that would require an open dot to be 
moved to a negative fret position. For example, you cannot shift the dots of a 
standard E guitar chord to the left, because it is not possible for the open B of 
the second string to be changed to an F# on the third (G) string!

If you hold down the Shift key when choosing Shift Dots Left (or when clicking 
on the Shift Dots Left  tool) Fretspace will adjust the fret position so that the 
shape  isn’t  transposed  to  a  different  root.  You  can  also  use  the  keyboard 
shortcut ⇧⌘← .

Shifting dots right
Select Shift Dots Right from the Box menu (shortcut: ⌘→) to shift dots to the 
right within a box, so that they are moved onto adjacent strings, away from 
the last (leftmost) string.
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Alternatively, click on the Shift Dots Right tool in the toolbar.

In standard guitar tuning, this creates a shape that is a fourth (five semitones) 
higher  in  pitch  than  the  original  shape.  Fretspace  preserves  the  musical 
intervals between the notes when dots are shifted in this way, and the shape 
may change as a result depending upon the current tuning. In standard guitar 
tuning, Fretspace preserves the distance between notes by moving dots one 
fret further away from the nut when they are moved from the third string to 
the second string. If you shift the dots of a standard E guitar chord by one 
position to the right, Fretspace creates a standard A chord.

E A

It is not possible to shift dots right if that would require a dot to be moved to a 
negative  fret  position.  This  doesn’t  happen  with  right-handed  shapes  in 
standard guitar tuning.

If  you  hold  down  the  Shift  key  when  choosing  Shift Dots Right  (or  when 
clicking on the Shift Dots Right tool) Fretspace will adjust the fret position so 
that  the  shape  isn’t  transposed  to  a  different  root.  You  can  also  use  the 
keyboard shortcut ⇧⌘→ .

Rotating dots
Rotating dots is similar to shifting dots left and right, except that it exploits the 
fact  that  in  standard  guitar  tuning  the  first  and  last  strings  are  tuned  to 
different pitches of the same note: so after dots have been moved left or right 
the dot that is now on the bottom or top string is duplicated and added to the 
string on the opposite side. This only works for tunings where the first and 
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last strings are tuned to the same note value, or are within a few semitones of 
each other.

Rotating dots left
Select Rotate Dots Left from the Box menu (shortcut: ⌥⌘←) to rotate dots to 
the left within a box.

Alternatively, click on the Rotate Dots Left tool in the toolbar.

In normal guitar tuning, this will change a standard C chord into a standard G 
chord.

C G

If  you  hold  down  the  Shift  key  when  choosing  Rotate Dots Left  (or  when 
clicking on the Rotate Dots Left tool) Fretspace will adjust the fret position so 
that  the  shape  isn’t  transposed  to  a  different  root.  You  can  also  use  the 
keyboard shortcut ⌥⇧⌘← .

Rotating dots right
Select Rotate Dots Right from the Box menu (shortcut: ⌥⌘→) to rotate dots to 
the right within a box.

Alternatively, click on the Rotate Dots Right tool in the toolbar.

In normal guitar tuning, this will change an open C/G chord into an F chord.
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C/G F

If  you hold down the Shift  key when choosing Rotate Dots Right  (or  when 
clicking on the Rotate Dots Right tool) Fretspace will adjust the fret position so 
that  the  shape  isn’t  transposed  to  a  different  root.  You  can  also  use  the 
keyboard shortcut ⌥⇧⌘→ .

Swapping dots
Swap Dots swaps the dots that are on the top and bottom strings. This is useful 
in finding alternative ways to play chords, especially with tunings (such as 
standard guitar tuning) where the top and bottom strings are tuned to the 
same  note  value,  or  are  within  a  few  semitones  of  each  other.  It  is  not 
particularly useful (and is therefore disabled) for scales. It is also disabled for 
chords  which  have  the  same  note  on  the  top  and  bottom  strings,  where 
swapping would have no effect.

Select Swap Dots from the Box menu (shortcut: ⌘/ ) to swap dots on the top 
and bottom strings.

Alternatively, click on the Swap Dots tool in the toolbar.

Here are some examples of chords with notes that can be swapped in this 
way:

Am7

A E A C G

Am7/G

G A E A C

C/G

G C E G C E

C/E

E C E G C G
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Inverting shapes
Chords and other shapes can be inverted so that they start from a different 
bass note. For example, a C chord can be played with a C in the bass (root 
position), or with an E in the bass (first inversion), or with a G in the bass 
(second inversion). A C7 chord can also be played with a Bb in the bass (third 
inversion).

One way to create chord inversions is to move the notes along the fretboard so 
that each note is replaced by the next chord note. If we replace each note in a C 
triad (C-E-G) with the next chord note, we will arrive at a first inversion (E-G-
C), and if we do that a second time we will have a second inversion (G-C-E). 
Fretspace has two Invert commands that invert shapes in this way.

Next Inversion
Choose Next Inversion from the Box menu (shortcut: ⌘I) to transform a shape 
into its next inversion. You cannot invert a shape to the next inversion if that 
would require notes that are higher than the 24th fret.

Alternatively, click on the Next Inversion tool in the toolbar.

A good example of chord inversions is to take a standard D7 guitar chord and 
invert it to D7/F# (first inversion), D7/A (second inversion), and D7/C (third 
inversion). This gives us a series of chord inversions that provide alternatives 
to the standard D7 shape.

D7

2 3

1

D A C F#

D7/F#

3
2

3 4

1

F# C D A

D7/A

7 1 1

2

1

A D F# C

D7/C

10
2

1 11

C F# A D

Three-note and four-note chord inversions are used by jazz guitarists to play 
chordal melodies, and can also be used to create moving bass lines. They’re 
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also a good way to create variants of standard root-position chords. Any chord 
can be inverted, but inversions of some chords may be difficult to play.

Previous Inversion
Choose Previous Inversion from the Box menu (shortcut: ⇧⌘I) to transform a 
shape into its previous inversion. You cannot invert a chord to the previous 
inversion if that would require notes that are lower in pitch than the unfretted 
pitch of a string.

Alternatively, click on the Previous Inversion tool in the toolbar.

Alternate voicings
Notes in a chord can also be rearranged without necessarily being inverted. 
Alternative arrangements are known as voicings,  and Fretspace provides a 
tool which generates alternate voicings. In contrast to the Invert tool, which 
moves shapes up and down the fretboard, this moves notes to other strings in 
the same part of the fretboard. Alternative voicings may also be inversions, if 
the bass note changes.

Here are some alternate D7 voicings:

D7

D A C F#

D7/F#

F# C D A

D7/C

C A D F#

D7/C

C F# A D

To cycle  through alternate  voicings,  choose  Next Alternate Voicing  (shortcut: 
⌘U) or Previous Alternate Voicing (shortcut: ⇧⌘U) from the Box menu, or click 
on the equivalent tool in the toolbar.
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Alternate Voicings  is disabled for scale and arpeggio shapes: it doesn’t make 
any sense to rearrange their notes in this way!

Fingerings
Fretspace automatically calculates  fingerings for  chord,  scale,  and arpeggio 
shapes, unless it thinks that a shape is impossible to play with four fingers 
(and a thumb). It normally chooses fingerings that do not require you to use 
your thumb, but it will occasionally use a thumb if it is needed for a particular 
shape. If Fretspace thinks that a shape is impossible to play, it will not display 
a fingering for that shape when Show Fingering is selected.

Editing fingering
If you prefer to use a different fingering from the one that Fretspace calculates, 
you can do this by choosing Edit Fingering from the Box menu (shortcut: ⌘Y).

When you choose this  option,  Fretspace displays  a  drop-down dialog that 
contains all the shapes that are currently selected, and displays their current 
fingering, with the first dot drawn in red to show that it is selected. To change 
the fingering of the note that is selected, simply press a number between 1 and 
4, or T for thumb. You can move between shapes within the dialog by using 
arrow keys or by clicking on them (as you would within a chart), and you can 
move  between  dots  by  tabbing  or  by  clicking.  Once  you  have  changed  a 
fingering value, Fretspace automatically selects the next dot.
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Notes Inspector
The Notes section of the Inspector panel displays the root note and degrees of 
the current chord, scale, or arpeggio, and allows you to change them using 
popup menus.

Changing the root note of a shape transposes it to a different position on the 
fretboard that is as close as possible to its current position.

Changing one or more degrees after  the root changes the type of  a  chord, 
scale, or arpeggio. For example, a major chord (with root, major third, and 
fifth degrees) can be converted into a minor chord by changing its second note 
from Major Third  to Minor Third.  We could also convert it  into a suspended 
chord by changing Major Third to Suspended Fourth. (Changing Major Third 
to Suspended Second will create a sus2 chord.) Changing the third note of a 
major chord from Fifth  to Augmented Fifth  will create an augmented chord, 
while changing the third note of a minor chord from Fifth to Diminished Fifth 
will create a diminished chord. Similarly, a dominant seventh chord can be 
converted  into  a  major  seventh  or  major  sixth  chord  by  changing  Minor 
Seventh  to Major Seventh  or Sixth.  Here are some examples of chords that 
have been converted in this way, starting from a standard A major chord:

A

R 5 R 3 5

Am

R 5 R b3 5

Asus

R 5 R 4 5

Asus2

R 5 R 2 5

Aaug

R #5 R 3 #5

Scales can be converted in the same way. For example, a Major scale can be 
converted into a Melodic Minor scale by changing its third note from Major 
Third to Minor Third, or into a Mixolydian scale by changing its seventh note 
from Major Seventh to Minor Seventh.
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G Major

7 B

C

D

E

F#

G

A

B

C

D

E

F#

G

A

B

C

D

G Melodic Minor

6 Bb

C

D

E

F#

G

A

Bb

C

D

E

F#

G

A

Bb

C

D

G Mixolydian

6
B

C

D

E

F

G

A

B

C

D

E

F

G

A

B

C

D

Menu options are disabled if it isn’t possible to convert a shape in its current 
position: a major third that is on an open string cannot be converted into a 
minor third because that would require a negative fret position.
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Chapter 5: Chord Picker

Using the chord picker
The chord picker is displayed when you select Insert Chord… from the Chart 
menu or click on the Insert Chord tool in the toolbar. It contains an extensive 
selection of chords from which you can choose a chord or group of chords that 
will  be  inserted  into  the  current  chart.  What  Fretspace  actually  does  is  to 
calculate almost every possible shape that can be used to play a particular 
chord  in  the  current  tuning.  However,  it’s  important  to  note  that  what  is 
possible for one person may be difficult or impossible for another. It’s best to 
ignore any shapes that you find difficult to play, or practice them gently for 
short periods. Don’t strain your hands or fingers trying to play shapes that you can’t 
play comfortably. You don’t need to play every possible shape when there are 
easier alternatives that might also sound better in many contexts.

The chord picker  is  a  dialog that  drops down from the top of  the current 
window.  It  can  be  resized  to  show  a  greater  or  smaller  number  of  chord 
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shapes. The chord shapes are arranged logically, so that shapes at lower frets 
are displayed before shapes at higher frets, and (for each fret position) similar 
shapes are grouped together: shapes with lower notes are displayed before 
shapes with higher or unplayed notes (starting with the lowest note on the 
lowest string).

If you wish to hear what a chord sounds like before you add it to a chart, 
select it within the chord picker and click on the Play button or press Space. 

Choosing a chord root
Use the Root popup near the top left of the chord picker to choose the root of a 
chord. This can be any note.

Choosing a chord type
Use the Chord popup (underneath the Root popup) to choose the type of chord 
that you are interested in. This displays a menu that gives you a wide choice 
of different types of chord that are playable in the current tuning.

The Chord menu is logically divided into six sections:

1. Power chords, such as C5. These are neutral chords that contain a root and 
a fifth but do not contain a third.

2. Major chords, such as C or Cmaj7. This section also includes suspended 
chords that can be used as major or minor chords but are grouped here for 
convenience.

3. Dominant chords such as C7 or C9.

4. Minor chords, such as Cm or Cm7.

5. Diminished chords such as Cdim or Cdim7.

6. Any other chord (see below).
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Within these sections,  submenus are used to group similar chords together 
and make the menu more manageable than it would be if it was presented as a 
single long menu. For example,  various kinds of altered dominant seventh 
chords  are  listed  in  a  single  submenu  together  with  standard  dominant 
seventh chords. Ditto for major sevenths, minor sevenths, dominant ninths, 
and other types of chord. Note that the chord from which other variants are 
derived  is  always  the  first  item in  a  submenu,  and  you can  also  select  it 
directly from the menu item to which the submenu is attached (e.g. click on 
C7 in the menu to which the C7 submenu is attached).

Minor  seventh  chords  that  have  a  flattened  fifth  are  also  known  as  half-
diminished chords.  Dominant  sevenths  with  a  sharp  ninth  (e.g.  C7#9)  are 
sometimes  known  as  “Hendrix  chords”  (Hendrix  used  them  for  their 
dissonant bluesy sound). 
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Choosing a chord inversion 
Use the Inversion popup (next to the Chord popup) to choose which inversion 
of a chord will be displayed. You can choose to display Root Position chords 
(which have the  chord root  as  their  lowest  note)  or  First Inversion,  Second 
Inversion, or Third Inversion chords (which have the third, fifth or seventh of 
the chord as their lowest note). You can also choose to display Any Inversion 
(which also includes the root position).

Fretspace defaults to showing Root Position chords for guitar tunings and Any 
Inversion chords for instruments that have fewer strings, because these tunings 
have fewer possible shapes and inversions are less important.

Choosing a chord by its notes
You can also choose a chord by the notes that it contains. This allows you to 
choose any chord, including ones that are not listed in the Chord  menu, or 
whose name you do not know. To choose a chord by its notes, simply click on 
notes  in  the  row  of  Notes  buttons  below  the  Chords  popup.  If  Fretspace 
recognizes these notes as belonging to one of the chords that are listed in the 
Chord popup, it will select that chord. If not, it will select the Other option (and 
will  usually  rename  with  the  name  of  the  chord  whose  notes  you  have 
selected).

When you choose notes in this way, Fretspace assumes that you want to see 
chords that  contain these exact  notes.  On the other hand, when you select 
chords from the Chord menu, Fretspace allows for the fact that chords do not 
always contain all their notes—less important notes, such as the fifth degree, 
may  be  omitted.  This  happens,  for  example,  with  the  shape  that  is  most 
commonly used to play C7. If you want to include these variant forms when 
you have selected notes from the Notes buttons, you can do so by deselecting 
the Exact checkbox. This allows variant forms to be displayed, including the 
the first three C7 shapes shown below, which lack a fifth degree.
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Choosing a string-type
Use the Strings popup near the top right of the dialog to choose which strings 
chords  should  be  played  on.  The  first  three  options  allow  you  to  choose 
between chords that are played on any combination of strings, chords that are 
played on adjacent strings, and “full” chords that are played on most strings, 
including the top strings. The Full Chord option selects chords that don’t have 
any unplayed strings after the first played strings, and that use a minimum of 
four strings (three on three-string tunings).  These are the chords that most 
people start with. The Adjacent option is similar to the Full Chord  option: it 
requires that all played strings should be next to each other, but it includes 
chords that have fewer than four notes, and it also allows unplayed strings to 
follow played strings, as in the following example:

C

3 1

3 3 3

R 5 R 3

C

8 1

3 4

2

R 5 R 3

These are common shapes for playing a C chord. They can be thought of as 
simplified bar chords, where the first finger frets the lowest note, but does not 
bar any following notes. Here are the barred equivalents:
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C

3 1

2 3 4

1

R 5 R 3 5

C

8 1

3 4

2

1 1

R 5 R 3 5 R

Any is the most general option. This includes shapes that are played on any 
combination of strings. When this option is selected, Fretspace displays shapes 
for almost every possible way that a chord can be played. Chords that have 
unplayed strings in between played strings can be played by finger-picking 
each string or by muting unplayed strings. This is typically done with a finger 
that is also fretting a nearby string: by resting part of this finger against the 
unplayed string, you can prevent it from sounding. A famous chord that is 
played  on  non-adjacent  strings  is  the  so-called  “Gretty  chord”,  which  the 
Beatles used in Michelle and in other songs. It looks like this:

F7#9

1

3

2

4 4

R 5 3 b7 #9

The fourth string is muted by ensuring that the third finger (playing the fifth 
string)  also  rests  against  the  fourth  string.  With  this  particular  shape,  it’s 
actually easier to mute the fourth string than not mute it!

You can also choose to display chords that are played on a more limited set of 
strings. 4-Note and 3-Note chords (on instruments that have more than four or 
three strings) use a subset of available strings. 4-Note (Any), 4-Note (Adjacent), 
3-Note (Any),  and  3-Note (Adjacent)  are  similar  to  the  previous  (Any  and 
Adjacent) options, except that they are limited to chords that have (exactly) 
four or three notes.  The other options display chords that are played on a 
particular set of strings,, such as the first four strings (4-3-2-1) or the first three 
strings and the fifth string (5-3-2-1) and other variations. Three-note and four-
note chords are used by jazz guitarists to play chordal melodies, and can also 
be used to create moving bass lines.
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If  you wish to display chords that use a combination of strings that is not 
listed as a menu option, you can specify the strings that you wish to use by 
selecting string numbers in the row of buttons that is displayed beneath the 
Strings popup when you choose a specific 4-Note or 3-Note option, or Other.

Choosing open chords
Select the Open checkbox if you wish to display chords that use open notes 
along with fretted notes that are further away from the nut than normal first-
position open chords. This kind of chord will sometimes combine close and 
wide intervals and have a distinctive ringing sound. Here are some minor 9th 
chords:

Em9

4
3

2

R b7 9 b3 5 R

Am9

5 1 2

R b7 b3 9 5

Dm9

5 1

2

R b7 b3 9

Displaying chord notes, degrees, and fingering
You  can  use  the  checkboxes  at  the  bottom  of  the  chord  picker  to  choose 
whether the picker should display chord notes, or chord degrees (or neither) 
and whether it should display fingering. You can also choose whether to color 
root notes.

Adding chords
To add a chord to the current chart, select it and click on the Add button. You 
can also choose and add multiple chords, or double-click to select and add 
chords without clicking on the Add button.
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Chapter 6: Scale/Arpeggio Picker

Using the scale/arpeggio picker
The  scale/arpeggio  picker  is  displayed  when  you  choose  Insert Scale/
Arpeggio… from the Chart menu or click on the Insert Scale/Arpeggio tool in the 
toolbar. It contains an extensive selection of scales and arpeggios from which 
you can choose the scales and arpeggios that you wish to be inserted into the 
current chart. Fretspace calculates almost any scale or arpeggio shape that can 
be played in box positions across the fretboard.

The  scale  picker  is  a  dialog  that  drops  down from the  top  of  the  current 
window. It can be resized to show a greater a or smaller number of scale and 
arpeggio shapes. The shapes are arranged logically, so that shapes at lower 
frets are displayed before shapes at higher frets, and (for each fret position) 
shapes that are easier to play are generally displayed before shapes that are 
more difficult to play.

To hear what a scale or arpeggio sounds like, select it within the scale picker 
and click on the Play button or press Space.
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Choosing a scale or arpeggio root
Use the first popup after the Scale/Arpeggio label at the top of the dialog to 
choose the root of a scale or arpeggio. This can be any note.

Choosing a scale or arpeggio type
Use the second popup after the Scale/Arpeggio label at the top of the dialog to 
choose the type of scale or arpeggio that you wish to view.

The Scale menu organizes scales and arpeggios into logical groups:
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1. Seven-note  scales  and  their  modes,  starting  with  the  major  scale  and 
continuing through other less common scales, including some fairly exotic 
scales and modes—such as the Neapolitan Major scale, which despite its 
name is actually a minor scale (there is also a different minor scale known 
as the Neapolitan Minor.) 

2. Bebop scales, which can be regarded as seven-note scales that have been 
modified by the addition of a chromatic jazz note.

3. Pentatonic  scales,  including  the  standard  Major  and  Minor  Pentatonic 
scales (which are actually modes of each other), and other modes of the 
Major  Pentatonic  scale.  Two  other  pentatonic  scales,  the  Dominant 
Pentatonic scale and the Dorian Pentatonic scale, are also modes of each 
other.

4. Blues scales, including the standard Major and Minor Blues scales (also 
modes of each other). These can be regarded as pentatonic scales that have 
been modified by the addition of a chromatic blues note: flattened third 
for Major Blues scales, and flattened fifth for Minor Blues scales. Other 
blues  scales  include:  the  Dorian  Blues  scale  (Dorian  Pentatonic  plus 
flattened  fifth),  the  Dominant  Blues  scale  (Dominant  Pentatonic  plus 
flattened  third),  and  the  Sus6/9 Blues  scale  (Sus  6/9 Pentatonic  plus 
flattened third).

5. Non-diatonic scales (scales that do not logically belong to a particular key) 
such as the Diminished, Whole Tone, and Chromatic scales.

6. Three-note arpeggios.

7. Four-note arpeggios.

8. Any other scale or arpeggio (see next section).

Choosing a scale or arpeggio by its notes
You can also choose a scale or arpeggio by the notes that it  contains.  This 
allows you to choose any scale or arpeggio, including ones that are not listed 
in the Scale  menu, or whose name you do not know. To choose a scale or 
arpeggio by its notes, simply click on notes in the row of Notes buttons that 
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follows the Scale popup. If Fretspace recognizes these notes as belonging to 
one of the scales or arpeggios that is listed in the Scale popup, it will select 
that scale or arpeggio. If not, it will display Other in the Scale popup.

Choosing a scale shape
The Shape popup allows you to choose between different scale shapes.

1. Standard Box shapes, which are used to play scales in one area (position) 
of the fretboard.

C Major Pentatonic

5 A

C

D

E

G

A

C

D

E

G

A

C

C Major

4
A

B

C

D

E

F

G

A

B

C

D

E

F

G

A

B

C

2. Diagonal shapes, in which scales extend diagonally across the fretboard. 
Diagonal shapes use patterns that repeat across pairs of strings. These are 
often  used  to  move  up and down the  fretboard  (linking  different  box 
shapes)  and  can  also  helpful  for  memorizing  note  positions.  Diagonal 
shapes  work  with  tunings  that  are  based  on  fourths  (e.g.  most  guitar 
tunings) and are not available for tunings that are based on fifths (e.g. 
mandolin tuning).
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C Major Pentatonic

3 G

A

C

D

E

G

A

C

D

E

G

A

C

D

E

C Major Blues

3 G

A

C

D

Eb

E

G

A

C

D

Eb

E

G

A

C

D

Eb

E

3. 2 Notes Per String,  3 Notes Per String,  and  4 Notes Per String  scales. 
These use a  fixed number of  notes  on each string.  Two-note-per-string 
shapes  are  often  used  for  pentatonic  scales.  Three-note-per-string  and 
four-note-per-string shapes can be used to play fast  scalar runs.  Three-
note-per-string  scales  are  suited  to  economy  picking  techniques,  since 
each  three-note  sequence  begins  and  ends  with  a  downstroke  when 
playing up the scale or with an upstroke when playing down the scale. 
Four-note-per-string  scales  are  suited  to  alternate  picking,  but  they 
involve large left-hand stretches.

C Major

5 A

B

C

D

E

F

G

A

B

C

D

E

F

G

A

B

C

D

C Major

8 C

D

E

F

G

A

B

C

D

E

F

G

A

B

C

D

E

F

Displaying scale/arpeggio notes, degrees, and fingering
You  can  use  the  checkboxes  at  the  bottom  of  the  scale  picker  to  choose 
whether the picker should display scale notes, or scale degrees, or fingering, 
or none of these. You can also choose whether to color root notes.
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Adding scales and arpeggios
To add a scale or arpeggio to the current chart, select it and click on the Add 
button. You can also choose and add multiple shapes, or double-click to select 
and add shapes without clicking on the Add button.
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Chapter 7: Preferences

Select  Preferences  from  the  Fretspace  application  menu  to  display  the 
Preferences dialog (shortcut ⌘,). This allows you to customize the way that 
Fretspace behaves.

General Preferences

Default Tuning
The  Default Tuning  option  allows  you  to  choose  the  default  tuning  that 
Fretspace will use for new charts.
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Mark Unplayed Strings
If this option is selected, Fretspace draws a cross at the top of unplayed strings 
in chord boxes.  Otherwise,  it  can be inferred that any string that does not 
contain a dot is unplayed.

Left-Handed
Select this option if you want Fretspace to display left-handed shapes (strings 
are reversed).

Tunings Preferences
The Tunings section of the Preferences dialog allows you to add, remove, and 
edit tunings.

There are three types of tunings that are displayed in this dialog.
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1. Standard tunings are displayed in bold text. These are built-in tunings that 
cannot be edited or removed.

2. Extra tunings are displayed in normal text. These include built-in tunings 
that can be removed, along with any other tunings that have been added. 
Guitar: DADGAD is a built-in tuning that can be removed. If you never use 
this tuning, you might choose to remove it from the list of tunings that 
Fretspace displays in its Tuning menus. Guitar: DADGAD is actually a fairly 
common  tuning  (among  guitarists  who  use  alternative  tunings).  Less 
common  tunings  include  Guitar: Fourths  and  Guitar: NST  (see  6-string 
tunings on page 42).

3. Disabled tunings are displayed in grey text. These are tunings that do not 
appear in Tuning menus unless they are used in a particular document.

Adding a tuning
Click on the Add button to add tunings. If the currently selected tuning is a 
disabled (grey) tuning, adding it will cause it to be enabled. Otherwise the Add 
button will add a new tuning that is based on the currently selected tuning, or 
on the default tuning if there isn’t a current selection. When you add a new 
tuning in  this  way,  Fretspace  displays  a  dialog in  which you can edit  the 
tuning (see next section).

Editing a tuning
You can edit a tuning by clicking on the Edit button or by double-clicking on a 
tuning. Fretspace displays a dialog where you can edit the tuning’s name and 
the notes that it uses.
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Naming a tuning
Use  the  Name  field  to  name  tunings.  Names  should  be  unique,  to  avoid 
confusion. Fretspace will display an alert if you try to save a tuning that has 
the same name as another tuning.

Setting the number of strings
Use the Number of Strings popup to select the number of strings that are used 
by  the  new  tuning.  Unless  you  are  creating  a  new  tuning  for  a  different 
instrument, you probably don’t need to change this.

Defining pitch values
Define  the  pitch  value  for  each  string  by  selecting  from  the  note  menus. 
Strings are numbered from right to left—string 1 is the first string from the 
right (high E in standard guitar tuning).
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Pitch notes are listed from high to low, with higher pitches towards the top of 
the menu and lower pitches towards the bottom. Pitch values are defined in 
Scientific Pitch Notation, which uniquely identifies notes by their pitch. For 
reference, middle C is C4 and the lowest possible note (in this notation) is C0 
(four octaves below middle C).3

Additional tunings must be unique. Fretspace will display an alert if you try 
to save a tuning that is identical to another tuning (i.e. that uses the same pitch 
notes).

Creating a tuning
The easiest  way to create a new tuning is  to choose a tuning that  is  most 
similar to the one that you want to use and click on the Add button. Then, in 
the dialog that is displayed, change the pitch of any strings that are different 
in the new tuning.

For example, to create a Banjo tuning in which the fourth string is tuned down 
to C, you would click on Add after selecting the standard Banjo tuning. Then, 
in  the  drop-down dialog  that  is  displayed,  change  the  pitch  of  the  fourth 
string from D3 to C3 (two notes below in the popup). Name the new tuning 
“Banjo: CGBD” or “Banjo C” (or any name that you prefer).

Removing a tuning
Tunings  can  be  removed  by  clicking  on  the  Remove  button  or  pressing 
Backspace.  If  they  are  built-in  tunings,  or  have  been  used  in  opened 
documents,  they  become  disabled  (and  are  displayed  in  grey).  Disabled 
tunings can be re-enabled by adding them again. Standard tunings (displayed 
in bold) cannot be removed, so the Remove button is disabled when they are 
selected.

3. Some instruments, including the guitar, are transposed in standard music notation—middle C 
in guitar notation has a pitch which is actually an octave below middle C (C3 rather than C4). 
Note values in Fretspace represent actual pitch values rather than music notation values.
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Document tunings
Fretspace saves information about the tunings that are used in a document. 
This allows documents to be shared with other users who might not otherwise 
have  these  tunings.  This  also  provides  a  way to  share  tunings  with  other 
users:  if  a  document  that  contains  an  added tuning is  opened on another 
machine, the Tunings panel of the Preferences dialog will display that tuning 
in grey. It can then be selected and added by clicking on the Add button.

Playback Preferences

Instrument
The Instrument option allows you to choose the MIDI instrument that will be 
used to play notes in a particular tuning. The top popup selects a tuning and 
the popup below it selects the instrument that will be used for that tuning.
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Play Scales & Arpeggios
This  popup  allows  you  to  choose  whether  scales  and  arpeggios  (and 
arpeggiated  chords)  are  played  in  ascending  or  descending  order,  or 
ascending and descending, or descending and ascending.

Tempo
This option allows you to choose the tempo at which scales and arpeggios are 
played. You can choose a standard metronome tempo from the popup, or type 
other tempos in the adjacent text box. Tempo is measured in beats per minute, 
and scales and arpeggios are played with four notes per beat.
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Appendix: New Features

New features in 1.3
1. There is a preference option for displaying left-handed shapes. See Left-

Handed on page 84.

2. Boxes can be exported in PDF, PNG, or JPEG format. See Exporting boxes 
on page 39.

3. Charts can be exported in PDF format via an Export Chart… command. See 
Exporting a chart on page 39.

4. It is possible to color selected scale notes in addition to the root note. See 
Color Selected Notes on page 46 and Selecting notes in a scale box on page 55.

5. If you hold down the Shift key when choosing Shift Dots Left or Shift Dots 
Right (or clicking on the equivalent toolbar items) Fretspace will adjust the 
fret  position so  that  the  shape isn’t  transposed to  a  different  root.  See 
Shifting dots left on page 58 and Shifting dots right on page 59.

New features in 1.2
1. The chord picker contains a set of Notes  buttons, which can be used to 

select any chord by choosing the notes that it contains. These are similar to 
the Notes buttons in the scale/arpeggio picker. See Choosing a chord by its 
notes on page 72.

2. New Pentatonic scales, including all five modes of the Major Pentatonic 
scale, and the Dorian Pentatonic scale. See Dorian Pentatonic scale on page 
18, and Choosing a scale or arpeggio type on page 78.

3. New Blues scales, including the Dorian Blues scale, the Dominant Blues 
scale, and the Sus6/9 Blues scale. See Dorian Pentatonic scale on page 18, 
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Sus6/9 Pentatonic scale and the B. B. King blues box on page 19, and Choosing 
a scale or arpeggio type on page 78.

4. Other improvements to the scale and chord pickers, including the ability 
to select a chord or scale without having to use submenus: e.g. clicking on 
Major Pentatonic in the following example will select the Major Pentatonic 
scale:

5. Alternate Voicing  tool,  which  generates  alternative  chord  voicings.  See 
Alternate voicings on page 64.

6. Swap Dots  tool,  which can be used to swap dots  between the top and 
bottom strings. See Swapping dots on page 62.

7. Holding down the Shift  key when choosing Move Dots Up  or Move Dots 
Down from the Box menu (or clicking on the equivalent toolbar items) will 
allow you to move shapes up or down by 12 frets. You can also use the 
keyboard shortcuts ⇧⌘↑ and ⇧⌘↓ . See Moving dots up on page 56 and 
Moving dots down on page 57.

8. The shortcuts for Invert Up and Invert Down have changed to ⌘I and ⇧⌘I. 
These are easier to use with non-English keyboards, and perhaps easier to 
remember.

9. Holding down the Option key while pressing one of the arrow keys causes 
the selection to be moved (or extended) to the start of the chart (Option ↑), 
end of the chart (Option ↓), start of the current line (Option ←), or end of 
the current line (Option →). See Selecting content with arrow keys on page 36.

New features in 1.1

1. Notes section of the Inspector panel. See Notes Inspector on page 66.
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2. Playback option. See MIDI playback on page 50 and Playback Preferences on 
page 88.

3. Strings popup in the chord picker (replacing the previous Type popup). 
See  Choosing  a  string-type  on  page  73.  This  includes  a  number  of  new 
options. If you choose Any from this popup, Fretspace will display shapes 
that are played on any combination of strings. These include almost every 
possible shape for a particular chord.

4. Shape popup in the scale picker. See Choosing a scale shape on page 80.

5. New Bebop scales.  See Bebop scales  on page 21,  and Choosing a  scale  or 
arpeggio type on page 78.

6. New Blues scales. See Choosing a scale or arpeggio type on page 78.

7. Mark Unplayed Strings preference. See Mark Unplayed Strings on page 84.

8. Color Root Notes option in chord and scale pickers.

9. Charts  can  be  copied,  pasted,  and  duplicated.  See  Copying  and  pasting 
charts on page 34 and Duplicating charts on page 34.

10. Option-clicking  in  a  scale/arpeggio  box  will  add  or  remove  matching 
notes in the scale/arpeggio. See Adding and removing notes on page 51.
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